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Pro-Stitcher Designer™ gives you the ability to 
quickly design, edit, customize, export and import any 
quilting motif  you can imagine. The full-featured, vector-
based drawing software allows you to create your own 
digital quilting files, printed pantographs or stencils. 
Pro-Stitcher Designer is compatible with all major 
quilting systems. It can open and save designs in all 
quilting formats, including batch save for converting a 
design into multiple formats in one easy step. 

The user interface of  Pro-Stitcher Designer makes it 
easy to learn and use. Lifetime program updates are 
always included for free. The user manual, tutorials and 
videos are all easily accessible from the software itself  
or by visiting www.prostitcher.com.  

Customizing designs and drawing designs has never 
been so easy. Create designs using the draw tools, with 
options including Pencil, Line, Curve, Arc and Bezier 
tools, and the artwork tools, which allow you to draw 
simple closed shapes with the click and drag of  the 
mouse.
 
Load a backdrop design and quickly create a new 
quilting motif. The Auto Digitizing tool allows you to 
create a design by simply importing a backdrop 
design and letting the software do the drawing for you. 
Creating designs with text is simple using the Text Tool, 
which converts any True Type font into a stitchable 
design. Designing wreath or square repeated designs 
is simplified by the Carousel and Reflect features.  

Customizable grids, including a diagonal grid option, 
make drawing designs straightforward. Automatic fill 
options, including stipple and crosshatch, add effects 
to simple shapes effortlessly. Quickly preview how 
repeated designs fill your quilting space for unique 
edge-to-edge layouts. 

Pro-Stitcher Designer is the software for creating  
paper or digitized quilting motifs that will turn you into 
a designer!
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Software / System Requirements

Minimum System Requirements
Windows 8 – 8.1; 1 gigahertz (GHz) or faster processor with support for PAE, NX, and SSE2;  
1 gigabyte (GB) (32-bit) or 2 GB (64-bit) RAM; 16 GB or 20 GB (64-bit) hard disk space;  
Microsoft DirectX9 graphics device with WDDM drive; USB port; 800 x 600 display; 
mouse, internet access.

Software Installation Instructions

Before starting the installation, you must be logged on as the Administrator on your computer. 
This means that if  you share the computer with someone else and have separate login ID’s, 
your ID must be the one named Administrator and allowed to install software on the computer.

Close all open programs. We suggest you disable your security software for the duration of  
the installation because anti-virus and anti-spam software can prevent installation. Please  
contact your security software provider to learn how to disable it. 

To install the Pro-Stitcher Designer software, there are two options.

  a) Option 1:  To install from a USB, insert the USB drive into your computer. In File Explorer, 
select the PSDesigner USB. Double click on the file PSD Setup to launch  
installation.

  b) Option 2:  After purchasing Pro-Stitcher Designer from www.prostitcher.com, click on the 
link to begin downloading the program.

To download the Pro-Stitcher Designer software, click on the following link: https://prostitcher.
com/prostitcher-designer-software/. The executable setup file will download to the downloads 
folder. Double click on the icon to begin the install. Follow the prompts to complete the 
installation. 

Proceed with the registration process to open the full functionality of  the software.

Registering Your Software

The computer on which the software is installed must be connected to the Internet to 
complete the registration process. If  you cannot connect to the Internet on that computer, 
refer to the directions at the bottom of  this section. 

Before any designs may be saved, the software must be registered. Disable any anti-virus, 
ad-ware and spyware software on your computer. We have found that these types of  programs 
may affect quilting design software if  they are active when you are registering. Disable your 
Windows firewall if  it is on. 
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Registering on a Computer with Internet Access
Double-click the Pro-Stitcher Designer icon on your desktop to 
open the software program. When the welcome page appears, 
select “Register Your Software”. 

Fill out the registration information completely. All fields with 
an asterisk (*) are required. 

  1. Fill in your contact information completely. 

  2.  Type in the serial number provided with your software.  
Include dashes. This number is case sensitive. 

  3. Click “Register Now”.

  4.  A license agreement will appear. Scroll down and click to accept terms. 

The software is now registered! The software is now fully functional.

Registering on a Computer Without Internet Access
Double-click the Pro-Stitcher Designer icon on your desktop to open the software program. 
When the welcome page appears, select “Register Your Software”. Select Pro-Stitcher 
Designer from the drop-down menu.

  1.  Fill in your contact information completely.  
All fields with an asterisk (*) are required. 

  2. Type in the serial number provided with your software. 

  3.  Write down the registration number from the form (line B).  
Take the number with you to a computer that has internet 

      connection. 

  4.  Using a computer with internet connection, go to  
http://www.esoftwareondemand.com/ProductRegistration.aspx

            a) Fill in all fields with an asterisk (*)

            b) The serial number is the one provided with your software.

            c) The registration number is the one you wrote down above in step 3.

            d) Click Submit. 

            e) The website will provide a validation code. 

  5. Write down the validation / activation code and take it back to your original computer. 

  6. Enter the code in lines B and C and click Register Now. 
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Registering Without Any Access to the Internet

Double-click the Pro-Stitcher Designer Icon on your desktop to open the software program. 
When the welcome page appears, select “Register Your Software”.

  1. Fill in your contact information completely. All fields with an asterisk (*) are required.

  2. Type in the serial number provided with your software. 

  3. Write down the registration number from the form (line B).

  4. Email support@prostitcher.com. or call us at 855-777-5257

  5. Be ready to provide the information from the screen (all items marked with an asterisk). 

  6.  Customer support will give you an activation code over the phone or email you a validation 
code or activation code. 

  7.  Return to your original computer and enter the code in lines B and C and click 
Register Now. 

Additional Registrations

Pro-Stitcher Designer software is licensed for two activations. Two activations are permitted 
per serial number at any given time. To install software on additional computers, request 
an additional activation from www.prostitcher.com/pro-stitcher-designer-support/. If  
your computer has to be replaced or Windows has to be reinstalled, also email  
support@prostitcherdesigner.com to request assistance for additional activations.

Software Transfer

Once registration is completed and the software is registered, you cannot transfer registration 
of  the SOFTWARE to another person (with either an individual or a single entity). This means 
you cannot sell, trade or give the software to any other person. Activation codes will only be 
given to the registered users of  this software.

File Formats 

When saving a design for the first time it is very important to save the file using the .c2s  
format. This is the native format for Pro-Stitcher Designer. The .c2s version of  the file 
“remembers” all of  the features, stitch types, fonts, etc. of  the design. Any time the design is 
re-opened to edit or change, it is best to use the .c2s format. It is a good practice to save and 
keep any file you may want to stitch again in the .c2s format.
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After a file has been saved in .c2s, save it in the stitch format for the computerized quilting 
system you use. Use the Save As feature to save the stitch file in the proper format for the 
machine and it may be saved directly to a USB, etc that the machine will read. It is not 
necessary to keep a library of  the designs in the stitch format. Any stitch format may be 
recreated from the .c2s file in the software. 

  Opens: 
  HQF, HQV, HQA, HQW, QLI, CQP, SSD, TXT, IQP, QCC, PAT, BQM, ANS, .c2s, also common 
  embroidery files

  Imports:

  SVG, AI, EPS, EMF, WMF, DXF, PLT, FCM, TT (true type fonts), BMP, JPG, PNG, TIF, GIF

  Save As and Exports:

  SVG, PNG, JPG, HQF, HQV, HQA, HQW, QLI, CQP, SSD, TXT, IQP, PAT, BQM

  Export:

  SVG, AI, PLT, DXF, FCM

Customizing the Software

General Options
Preface – It is not necessary to change the defaults in the Settings Tab>General Options to 
use the software. The parameters are designed to provide each user with the software options 
particular to their machine and personal preferences. 

The General Options box allows you to globally change many settings for the software. When 
you make a change in the General Options box it will keep these settings as default settings 
every time you open the software. In the General Options you can make changes to the  
working environment, machine, grid and view. 

To access the General Options box:

 • Select the Settings Tab.  

  • Next, select General Options from the ribbon.

The Options box will appear on your screen.
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Tabs available in the General Options box include:

         Environment Tab  
         In this section you can change the units of  measure, select a default 
         style, select a default thread palette, change the language and set 
         how often the program will Autosave.

         Machine Tab  
         In this section you can set your Quilting Space to match your frame 
         and change the units of  measurement, choosing either inches or 
         millimeters.

         Grid Tab  
         In this section you can set the parameters for the grid by selecting  
         Spacing for both the Horizontal and Vertical. Other options available 
                                       include choosing colors for both the spacing options and the Major 
                                       grid lines. 

                                       In the style section, you can choose how your lines will display on your 
                                       workspace. Choose to have a rectangle based grid, a diamond based 
                                       grid, or both on your design page. Select to have objects you move 
                                       snap to the grid, guidelines and anchor points as desired. This is 
                                       helpful for aligning objects. You can choose to display the grid as 
                                       dashed or solid lines or dots. Finally, you can sharpen the snap 
                                       resolution and choose to have the grid show in front of  the design. 

         View Tab  
                   In this section, choose the color a design element will display when 
                                       you select it in the software. You can also choose to enable on 
                                       screen text typing, show property tabs as icons, auto close zoom and 
                                       pan tools and use the left click on palette to apply color. 

Note – Changes to any of  the General Options will not apply to designs currently. 
It will only apply to designs opened after the change has been implemented. 
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Machine Tab

      1. Quilting Space: The quiltable space in your 
                                                                      frame. You set this according to frame size. 

      2. DXF Default Units: Select whether the 
                                                                      measurement units in DXF files should be in 
                                                                      inches or metric in the dropdown menu. 
 

Environment Tab

      1.  Units: Select the preferred default, Inches or Met-
ric. This may also be changed for immediate dis-
play by right clicking the ruler bar of  the display 
screen. 

      2. Default Style: Only one setting is available. No 
                                                                      need to adjust.

      3. Default Palette: The default palette is used when 
                                                                      you are creating a new design. When loading a 
                                                                      design that doesn’t have color information, there 
                                                                      are numerous thread manufacturers from which to 
                                                                      choose. 

      4. Language: from the drop-down arrow choose from   
                                                                      English, Chinese, Dutch, French, German, Italian, 
                                                                      Portuguese, Spanish or Korean. 

      5. Auto every (min): Allows you to choose how often 
           the software will Autosave.
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Grid Tab
      Spacing

      1. Horizontal Spacing: Set the horizontal spacing on 
                                                                      the grid. Defaults to .25 inches or 10 mm metric. 

      2. Vertical Spacing: Set the vertical spacing on the 
                                                                      grid. Defaults to .25 inches or 10 mm metric. 

      3. Color: Choose the color for your minor lines in 
                                                                      your grid. 

      

      Style      
      4. Lines Style: Set the style of  grid to dashed line 
                                                                      (default), solid lines or dots. 

      5. Shape: Choose the shape the grid will be shown 
                                                                      in. You can choose Rectangle (default) or 
                                                                      Diamond, or both.

      

      Major      
      6. Horizontally every (lines): Set the horizontal 
                                                                      spacing on the grid. Defaults to 4, meaning every 
                                                                      4th line. This will give you a major line every inch 
                                                                      if  you have your spacing set to .25 inches. 

      7. Vertically every (line): Set the vertical spacing on 
                                                                      the grid.  Defaults to 4, meaning every 4th line. 
                                                                      This will give you a major line every inch if  you 
                                                                      have your spacing set to .25 inches. 

      8. Color: Choose the color for your major lines in 
                                                                      your grid. 

      

      Options      
      9. Snap to grid: if  selected, edit point to the closest 
                                                                      grid point when created or selected. 

              10. Snap to guidelines: If  selected, edit point to the 
                                                                      closest guideline when created or selected. 

              11. Snap to anchor points: If  selected, edit point to 
                                                                      the closest anchor point when created or selected. 

              12. Snap resolution (px): Change the snap resolution 
                                                                      for more precise placement of  points.

              13. Show in front of design: If  selected, the grid 
                                                                      will show in front of  the design.
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View Tab

      1. Highlight selection: This option will allow the user 
                                                                      to turn “off” or “on” (default) a highlighted color on 
                                                                      a selected object. The color of  the highlighted 
                                                                      object may be changed, at any time, for easier 
                                                                      editing. Click the color selection box to change the 

      2.  Show property tabs as icons: If  selected, the tab-
sin the side bar will be displayed as icons instead 
of  names. This option eliminates/reduces scrolling 
across the tabs when viewing object properties. 

      3.  On screen text typing: If  selected, a cursor will 
appear on the design page for text input instead 
of  forcing input into the small text input box on the 
Properties >Text side bar. 

      4.  Auto close zoom and pan tools: Automatically 
revert to select or shape after using zoom or pan. 

      5.   Use left click on palette to apply color: If  selected, 
this option will allow you to left mouse click on 
acolor in the palette to apply to the design. 
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Navigating the Software 

Design Page Overview

Tabs: Select any tab to display 
its buttons and functions. 

Ribbon: The buttons on the Ribbon change 
according to which tab is selected. 

Thread Palette: Displays the information about colors and thread of elements 
in the design. It also allows for color changing, adding and removing. Click on 
the + or – to add or remove colors from the palette. 

Designs View: Displays de-
signs and design folders.

Sequence View: Displays design 
sequence by color and design. 

Navigator View: 
Displays a box 
around the 
design and a 
slider to zoom in 
on the design. 

Properties box: 
Displays and 
allows editing 
of all 
information 
about the 
selected design 
or object. 

Effects View: Displays outline and 
fill effects available when design or 
artwork is selected.

Pan Scroll Bars

Design 
Start
Point

(green)

Open Design Tab(s): Multiple designs may be 
open at any one time. The current design name 
is designated with an X next to the name. 

Design 
End 
Point
(red)

Rulers

Quick
Access 
Toolbar: Buttons 
shown here are 
always visible. 
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Sequence View 
The Sequence View is a very powerful panel, which 
is often overlooked and underutilized. This window 
provides a snapshot of  the entire design. In the 
Sequence view, the stitching order of  the design 
may be altered. Click and drag a segment or design 
element into a different location. 

This panel provides a snapshot of  the entire design, 
including:

   Sequence Features:

 The Sequence View will quickly and easily allow you to turn on / off  the view of  a 
 given segment. This helps greatly when editing objects or figuring out where all the 
 elements of  a given segment are located in a design. 

 The Sequence View is also the area in which you change the sewing order of  the 
 design. You can click and drag a segment or design element into a different location 
 by simply selecting it and dragging it into the desired location. 

  Plus/Minus box – click to expand / collapse elements pertaining to the color.

  Eye Symbol –  use this to turn on / off  the view of  a design element. When off, the 
design color segment is still in the design, but it is not visible and may 
not be selected or altered.

 Lock Symbol –  use this to lock / unlock a design color segment in the sequence. When 
locked, the properties of  that element may not be changed in any way. 

 

 

• The stitching sequence of  the block.

• A small view of  each object and its color.

• The number of  stitches in that section of  the 
design.

Sidebar 
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   Design Page Overview

 Designs View is a feature that enables a design to be added into any project on the  
 open design page with a simple drag and drop. There are folders containing designs 
 already loaded in the library. Folders may be added to the designs view and designs 
 may be added to existing folders.

 The Designs View has two components:

 The Folders section contains the designs. It is located in the upper section of  the 
 window. The folders contain the designs added and organized by the user.

 The Design Viewer is located just below the folders. To access and view the designs  
 simply left mouse click on the folder. When you click a folder the designs will appear in 
 the bottom section of  the screen. Scrolling through the design viewer displays all the 
 designs located in that folder. Left click to select the design and hold while dragging it 
 onto the design page. Release the mouse click, the design is now in the project. You 
 can also double click on the design and it will open on a new design tab. 
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Folders 
   New Folder - right mouse click

 1. Select New Folder.
 2. Type the name of  the folder.

 3. Click anywhere on the screen to apply the
      new name.

 4. Designs may now be added to the newly 
      created folder.

   Rename a Folder

 1. Select the folder.

 2. Right mouse click and select Rename Folder.
 3. Type the new name in the name box.

 4. Click anywhere on the screen to apply the new name.

   Delete a Folder

  The folder must be emptied of  all files before it may be deleted. This precaution will 
help to ensure no folders are deleted accidentally and a reminder to back up any  
necessary design files.

   New Link

  The New Link feature allows you to link a folder or design saved on your computer or 
a USB to your Design view window. This essentially creates a shortcut to the folder or 
design through your Design View window. A link will only be created with a folder (or 
design) in a format Designer imports is linked.

 1. Select the folder. 

 2. Right mouse click; select New Link. 

 3.  The browser for folder dialog box will appear on the screen. Select the folder on your 
computer or USB stick to link. 

 4. Follow the instructions to add the link to the folder. 

 5. The new link will be added under the software folder and the designs will be seen 
               in the window below.

 6. If  you want to rename the link or delete the link, right mouse click on the link 
               folder. A dialog box will appear and give these options. 

   Show Contents

 1. Select the folder. 

 2. Right mouse click; select Show Contents. 

 3. The file contents dialog box will appear on the screen.
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   Refresh a Folder

 When designs are added to a folder, either existing or newly created, the designs 
 will not display until the folder is refreshed or the next time the program is started. 

 1. Select the folder. 

 2. Right-mouse click; select Refresh.
 
   Add Designs

 1. Select the folder for the designs. 

 2. Right mouse click and select Add Designs.

 3. In the Open box displayed, navigate to the folder or drive on your computer 
     which contains the design(s).

 4. Select the design(s) to add to the folder.

 5. Select Open.

The designs are now inside the folder and ready to use.

Design Viewer
Right-mouse click to access the menu. 

   Show Contents

 1. Right click on a design to select it (as 
                shown above) and display the dialog box.

 2. Click on Show Contents to open a file’s 
               contents dialog box to see the contents.

   Refresh

 1. Right click in the lower section of  the 
                 screen to display the dialog box.

 2. Select “Refresh” to redisplay the 
                 contents of  the folder. 

   Add Designs

 1. Right mouse click and select Add Designs.

 2. In the Open box displayed, navigate to the folder or drive on your computer 
                which contains the design(s). 

 3. Select the design(s) to add to the folder.

 4. Select Open.

The designs are now inside the folder and ready to use.
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Effects View 
Displays outline and fill effects that are available 
when design or artwork is selected. The Effects 
options become available when a design is 
selected. Choose to apply different Outlines 
or Fills to your artwork or designs.

   Outlines
 Run – The standard straight stitch for all 
  designs.

 Motif – Choose a motif  stitch from the drop 
    down menu to replace the standard 
    straight stitch. 

   Fill
 Use this option to fill a closed object with different fills: standard, motif, shape, 
 artwork, grid (crosshatch), stippling and wave. 

• The Navigator Tab allows you to easily move around your design page, especially if  you 
have a very large design loaded.

• Using the slider bar at the bottom, zoom in and out on a specific area of  the design 
page.

• Also use the mouse to click and move the view of  the design page inside the Navigator 
Window.

These two windows are moveable. Click 
on the top bar of  the window and drag 
the window with your mouse. Release 
the click to place the window. You may 
place the windows anywhere on your 
computer screen. To put the window 
back on the right of  your design page, 
move the window clear to the right. A 
shadow will appear indicating where the 
window will lock into place.

Navigation View
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Quick Access Tools

The following tools enable different methods of  viewing designs, objects, stitches, commands 
and other details of  a design. 

  ICON                SHORTCUT            FUNCTION DEFINITION

Left click to select an object(s) in the 
design area. Hold the Ctrl key to se-
lect multiple objects. Click and hold 
down the left mouse button and drag 
a box around the areas to select.

Q Select Tool

Select an object with this tool to edit 
the outline, angle lines and start/stop 
points. 

E Shape Tool

Left click on the icon to select the 
tool, then click on the Design page 
to zoom in on a particular area. Tip: 
Double click on the icon to fit the 
contents of  the design page on the 
screen or press the space bar. 

Z Zoom Tool

Select the icon, then left click and 
hold to relocate the display area of  
the screen. 

M Pan Tool

Select the icon, click and hold the left 
mouse button down while dragging to 
measure an area on the screen. 
The measurement will be in the same 
units as the screen ruler. 

R Ruler Tool

Displays the chosen thread palette. To change the palette, select Setting tab, General Options 
and on the Environment page, click under Default Palette. A drop down menu allows you to 
select by manufacturer.

To change the thread color of  a design, select the design, then right click on the desired color 
in the thread palette. 

Thread Pallette
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Tabs & Features Buttons

     Home Tab

  ICON                SHORTCUT            FUNCTION DEFINITION

Select to reverse a previous action. 
The only limit to the number of  times 
undo may be used in sequence is 
when it reaches the point that the 
design was saved, or a blank page 
(if  the design has not been saved). 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. While a draw tool is 
active, use the Backspace key to 
undo the last point.  

CTRL+Z Undo

Select to restore the undone action. 
Again, this is limited by the number of  
restores since the last save of  the file. 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. 

CTRL+Y Redo

Select to open a new design page. 
The name of  the file will default to 
“Design X” where x is the next 
number of  the new page opened 
in this session. 

CTRL+N New Page

The Home Tab includes Undo and Redo buttons. New button allows you open a new design 
page. You can save a design here or open a new design. Print preview options are available. 
Click on Send to send a design to Pro-Stitcher. And finally, you can open the Area library from 
this tab. 

    Edit Features

    File Features
  ICON                SHORTCUT            FUNCTION DEFINITION
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  ICON                SHORTCUT            FUNCTION DEFINITION

Click to save the current design. If  it is 
a new design that has not been saved, 
the “save as” dialog box opens to 
allow input of  the location, name and 
format of  the design. Note: to change 
the name or location of  a previously 
saved file, select File>Save As. 

CTRL+S Save

Select to access the Print Preview 
screen to print templates, color charts, 
etc. of  the design. See the print 
feature for optional settings. 

Print Preview

Send the current design to 
Pro-Stitcher. 

Send to PS 
Quilting 
Machine

    File Features (continued)

 Open a File 

    Library Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Open the Area Library. Area Library

Select to open a new design. A library 
will open. Select a design and click 
open to load the design to your  
design page.

CTRL + O  
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Tools Tab

Use the Tools Tab to access edit tools, clipboard features, draw tools, shapes, outlines, add 
design notes, create functions, change tools, import and use backdrops and save designs as 
a batch. 

  ICON                SHORTCUT            FUNCTION DEFINITION

Select to copy the selected 
(highlighted) object(s). The copied 
object(s) are temporarily available 
on the “clip board” to be pasted to 
another location or another design.

CTRL+C Copy

Select to remove the selected 
(highlighted) object(s). The cut 
object(s) are temporarily available 
on the “clip board” to be pasted to 
another location or another design. 

CTRL+X Cut

Select to insert any copied or cut 
objects to a new location or design. 
Objects may be pasted multiple times 
as long as they are on the “clip board”. 

CTRL+V Paste

Select to delete the selected 
(highlighted) object(s). DEL Delete

    Edit Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select to reverse a previous action. 
The only limit to the number of  times 
undo may be used in sequence is 
when it reaches the point that the 
design was saved, or a blank page 
(if  the design has not been saved). 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. While a draw tool is 
active, use the Backspace key to 
undo the last point.  

CTRL+Z Undo

Select to restore the undone action. 
Again, this is limited by the number of  
restores since the last save of  the file. 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. 

CTRL+Y Redo

    Clipboard Features
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Mouse left click for straight lines, 
mouse left click and drag for curves, 
immediately controlling the curve 
by moving the mouse in the desired 
direction. Pressing Ctrl on your key-
board and then mouse left click and 
moving the anchor will create a cusp 
point. One tool for all types of  curves 
and lines. Mouse right click to finish. 

B Bezier

Arcs are parts of  circles. Mouse left 
click from point to point, three points 
for the first arc, then only two for the 
following arcs. Mouse right click to 
finish. 

A Arc

    Draw Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Click from point to point for straight 
lines, right-click to finish.

L Line

Click from point to point for curved 
lines, mouse right click to finish. Only 
a few points are needed for nice 
smooth curves. Fewer points make 
smoother curves. 

C Curve

Click on the Pencil tool (or press letter 
P on keyboard) and draw by moving 
the mouse. Release the mouse to 
pause drawing, click and move to 
continue. Mouse right click to finish. 

PencilP
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    Notes Features

  ICON                SHORTCUT            FUNCTION DEFINITION

Notes on the Design Page are 
different from Copyright Notes. Notes 
on the Design Page will NOT end up 
in any quilt format. The notes can be 
printed along with the design; this 
function is useful for printable 
pantographs, to number patchwork 
pieces, for class handouts, etc. 

    Shapes Features

  ICON                SHORTCUT            FUNCTION DEFINITION

Artwork Input select icon, then select 
the type of  artwork to create: rectan-
gle, ellipse, triangle, diamond, star, 
rounded (rectangle), hexagon, leaf, 
heart, flower and spiral. 

O Artwork Input

  ICON                SHORTCUT            FUNCTION DEFINITION

Finish drawing an object by mouse 
right clicking, click on this button 
if  your pattern has to be a closed 
shape, so it can be filled with stitches. 

Close Outline

When a design is selected, use this 
button for those times when you want 
to switch the start and end points, 
such as when you rotate or flip a 
design and the start point is now at 
the right side of  the design. 

Swap

    Outlines Features
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    Create Features

  ICON                SHORTCUT            FUNCTION DEFINITION

Input text using selected fonts. Also, 
use instead of  the select tool to edit 
text as text instead of  objects. 

T Text Tool

Wizard function to create a stitch file 
from artwork. 

Auto Digitizing

Select an object(s) or design, select 
the icon then click on the design 
screen while holding down the left 
mouse button to drag and rotate a 
copy(s) of  the selected object. 

DuplicateCTRL+D

With the object(s) selected, click the 
icon to display the repeat menu and 
determine the number of  repeats of  
the design both horizontally and 
vertically, with additional parameters. 

Repeat

Select the design or object(s) to be 
placed in a wreath configuration. 
Specifics may be adjusted in the 
Carousel Template dialog box. 

Carousel

Select the design or object(s) to be 
placed in square configurations. 
Specifics may be adjusted in the 
Reflect Template dialog box. 

Reflect

Select the design or object(s) to 
create echo stitching or a boundary 
around. Specifics may be adjusted in 
the Echo Quilting dialog box. 

Echo 
Quilting
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    Backdrop Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select this tool to open an image from 
your computer into the work area. 
While selected, the image may be 
resized, scaled and a new horizon 
applied. 
Note: Only one background is 
allowed per design. 

Backdrop
Tool

Select a draw tool and click button 
to activate. Used in conjunction with 
backdrop images, artwork images, 
etc. 

Magic Wand

  ICON                SHORTCUT            FUNCTION DEFINITION

Open a design and convert to art-
work. Create a path, which can be a 
line or a closed shape. Select both 
design and path. Select Repeat on 
Path. Select the division length (size 
of  artowke), Reflect or reflect every 
other to modify the repeat. Click OK 
when finished.

Repeat
on Path

Select a design or object(s) to add 
rays, as a continuous path, around 
a selected closed shape. The shape 
must be a simple closed shape with 
not too many inside curves and no 
backtracking. Specifics may be 
adjusted in the Rays dialog box. 

Rays

    Create Features (continued)

    Change Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Use to split an object into two or more 
objects. The object must be in artwork 
form. Select the object with the shape 
feature, then left mouse click on one 
side of  the object and drag across to 
the other side. Right click twice and 
from the pop up window select Up-
date Path. In the Sequence Property 
window, right click on the object and 
select Break Apart from the menu. 

Slice
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Used to create multiple file formats of  
the same design. When a design is 
ready to be saved in all quilt formats, 
add a copyright note/designer name 
in the notes field in the property 
panel first. Then you can save in all 
supported quilt formats in one step. 

Batch
Conversion

    Other Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Modify Tab

    Edit Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select to reverse a previous action. 
The only limit to the number of  times 
undo may be used in sequence is 
when it reaches the point that the 
design was saved, or a blank page 
(if  the design has not been saved). 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. While a draw tool is 
active, use the Backspace key to 
undo the last point.  

CTRL+Z Undo

Select to restore the undone action. 
Again, this is limited by the number of  
restores since the last save of  the file. 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. 

CTRL+Y Redo

Select to flip the design on a 
horizontal axis.

Flip 
Horizontal

Select to flip the design on a 
vertical axis. 

Flip 
Vertical

  ICON                SHORTCUT            FUNCTION DEFINITION

Modify Tab includes all the tools that allow you to rotate, crop, group, center, shape and  
distribute your designs.

    Rotate/Flip Features
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  ICON                SHORTCUT            FUNCTION DEFINITION

Select to rotate the selected object(s) 
to the right 45 degrees. May be se-
lected multiple times. To rotate a pre-
cise number of  degrees, left mouse 
click on the triangle in the bottom 
right corner of  the button and select 
Change Value. Enter a specific value 
in the Change Value box. 

Rotate Right

Use the Transform feature to manu-
ally rotate or resize an object(s) or 
design(s). Select the object(s) or 
design(s) and then select the Trans-
form button. This opens the Transform 
properties window. Change the width 
and height of  a design separately or 
maintain the aspect ratio. Change the 
position on the Grid using Postion X 
and Y. Rotate a design by a precise 
degree. Flip the design on a horizontal 
or vertical axis.

Transform

    Utility Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select two overlapping objects in art-
work format. Click crop button to crop 
out design to the back.

Crop

    Rotate/Flip Features (continued)

Select to rotate the selected object(s) 
to the left 45 degrees. May be select-
ed multiple times. To rotate a precise 
number of  degrees, left mouse click 
on the triangle in the bottom right 
corner of  the button and select 
Change Value. Enter a specific value 
in the Change Value box. 

Rotate Left
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    Arrange Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Use the Align options to position the 
selected design(s) in relation to each 
other. Choose from Left, Horiz. Center, 
Right, Center, Top, Vert. Center and 
Bottom. Your last selection will be 
visible on the Align button until 
another is selected. 

Align

Groups two or more objects togeth-
er. When selecting an object that 
belongs to a group it will select all 
objects in that group. 

Group

Breaks apart grouped objects. When 
selecting grouped objects all the 
items will be broken apart into individ-
ual objects and then can be selected 
separately. 

Ungroup

CTRL+G

Click to move the selected objects(s) 
to the top of  the design which is the 
last item in the stitching sequence. 

To Front

Click to move the selected object(s) 
to the bottom of  the design which 
is the first item in the stitching 
sequence. 

To Back

    Center Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select an object and click this button 
to center it on the 0,0 position of  the 
rulers. 

To Origin

Select an object and click this button 
to center it on the 0,0 position of  the 
grid. 

To Grid
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    Shaping Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select two simple closed shape 
objects in artwork format that are 
overlapping and click this button to 
combine. The last design placed will 
be on top and the two objects will be 
combined. 

Trim

Select two simple closed shape 
objects in artwork format that are 
overlapping and click this button to 
weld them together. The outline of  the 
two shapes will become one 
continuous shape. 

Weld

Select two simple closed shape
objects in artwork format that are 
overlapping and click this button to 
leave behind only the part of  the 
objects that intersect.  

Intersect

    Distribute Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select multiple objects (3+), then 
click to allocate equal horizontal 
spacing between them. The left and 
right margins will not extend further. 

Distribute 
Horizontal

Select multiple objects (3+), then 
click to allocate equal vertical 
spacing between them. The top
and bottom margins will not expand 
further. 

Distribute
Vertical
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Preview Tab 

The Preview Tab allows you to assign stitch or artwork format, simulate stitchout, and 
optimize your Entry/Exit in designs.

  ICON                SHORTCUT            FUNCTION DEFINITION

Select an object(s) and click to            
convert to stitches. 

Convert to 
Stitches

Select a design(s) and click to                 
convert to artwork. 

Convert to
Artwork

    Preview Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select to display a virtual sew-out 
of  the design. When this button is 
selected, manipulate the arrow keys 
and slider bar to view the stitch-
ing sequence of  a design before                 
committing it to fabric. 

Stitchout

    Edit Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Select to reverse a previous action. 
The only limit to the number of  times 
undo may be used in sequence is 
when it reaches the point that the 
design was saved, or a blank page 
(if  the design has not been saved). 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. While a draw tool is 
active, use the Backspace key to 
undo the last point.  

CTRL+Z Undo

Select to restore the undone action. 
Again, this is limited by the number of  
restores since the last save of  the file. 
This function is visible on the ribbon 
under the Home, Tools, Modify and 
Preview tabs. 

CTRL+Y Redo

    Convert Features
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View Tab

Use the View Tab to turn on or off  elements on the design page, such as grid, stitches, artwork, 
start/end points, interlocking preview, quilting space, realistic mode, notes, folders and backdrop. 

  ICON                SHORTCUT            FUNCTION DEFINITION

Select the button to turn on or off  the 
grid on the design screen. Grid

Show or hide stitches. If  stitches are 
off/hidden, only the shape of  the 
object is displayed. 

CTRL+SHIFT+S Stitches

If  the button is highlighted, click to 
dismiss the artwork, notes, etc. from 
the display area. Click again to turn 
on the button and the artwork, notes, 
etc.

Artworks

Select the button to show or hide the 
start and end points of  a design. Start / End

Select the button to show or hide 
interlocking preview. This features 
allows you to see if  your design 
repeats well while you are drawing 
it. It’s easy to see where details need 
to be added to prevent gaps in an 
overall design. This view is available 
in artwork or stitch objects. 

Interlocking

Select to view the quilting space. 
Adjust the size of  your quilting space 
under Settings Tab>General 
Options>Machine Tab. 

Quilting 
Space

    Optimize Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Click to improve the entry and exit 
points of  sequential objects for the 
closest point connection. Reduces 
jumps. 

Optimize 
Entry Exit

Display Features
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  ICON                SHORTCUT            FUNCTION DEFINITION

Click on the button to toggle back 
and forth between regular view and 
a more realistic (three dimensional) 
representation of  the design. 

Realistic

Click on the button to turn on or off  
notes on the Design Page. These are 
different from Copyright Notes. Notes 
on the Design Page will NOT end up 
in any quilt format. The notes can be 
printed along with the design; this 
function is useful for printable 
pantographs, to number patchwork 
pieces, for class handouts etc.

CTRL+3

Notes

Select the button to open a drop 
down menu which allows you to open 
designs, images or library files from 
your computer’s hard drive. 

Folders

Select the button to turn on and off  
the backdrop in your design page. Backdrop

Use this set of  buttons to quickly 
zoom to fit your design in the page, 
see your design at 1:1 or zoom to 
your selection by clicking on each 
separate button. 

Zoom

    Zoom Features
  ICON                SHORTCUT            FUNCTION DEFINITION

    Backdrop Features
  ICON                SHORTCUT            FUNCTION DEFINITION

Display Features (continues)
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  ICON                SHORTCUT            FUNCTION DEFINITION

Select to open a link to online video 
and .pdf  tutorials. 

Select this button to open an infor-
mation box with program info, version 
number and copyright info. A direct 
link to the prostitcher.com website is 
also included for a computer or tablet 
that is connected to the internet. 

Select this button to open the home 
screen. 

Settings Tab

Described in the General Options section above. 

Tutorials

About

My Home

Help Tab

This tab includes help items like how-to video tutorials, program information, version 
number and copyright info, a link to the home screen, the registration information and 
checking for updates. 

Set the defaults for options for your 
environment, including the units of  
measurements, thread palette, lan-
guage and Autosave setting. Under 
the machine tab, set up your quilting 
space.  Grid options, like spacing, 
styles and shapes are all set here. 
The view tab allows you to change 
the highlight selection color, property 
tab icons, on screen text typing, auto 
close zoom and pan tools and using 
the left mouse button to apply a new 
thread color to a design.

General 
Options 
Settings 

  ICON                SHORTCUT            FUNCTION DEFINITION
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  ICON                SHORTCUT            FUNCTION DEFINITION

Select this button to display the 
activation dialog. This is where you 
register and unregister your software. 

Select this button to check for 
updates. If  you are connected to the 
internet, the software will automatical-
ly check. If  you are on a tablet 
without internet access, insert USB 
with the saved update into the 
appropriate drive, then click on this 
button to run the update. 

Registration

Updates

Right Mouse Click Options

There are many additional options available when you right mouse click on a selected object.  
Only the available options for that object will display. Some of  these options are only available 
when you right mouse click; others may also have a button. Either way is acceptable.  

    View
  Use this to lock or unlock your view, show, 
 hide filter or fade an object(s).

    Cut
  Use this to cut the selected object. 

To use,select an object and then right 
mouse click and select “Cut”. This will 
remove the selected object from the 
project, but put it in memory to be 
pasted somewhere else.

    Copy
 Use this to copy the selected design element. To use, select an object and then 
 right mouse click and select “Copy”. This will create a copy of  the selected object 
 that can then be pasted into the project.

    Paste
  Use this to paste the cut / copied object. Right  mouse click and select “Paste.” 

anywhere on the design page. This will paste a copy of  the cut or copied element 
onto the design page.

Right Mouse Click Options

Help Tab (continued)
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   Duplicate
  Use this to duplicate the selected object. The duplicate will be placed on the clipboard 

to paste or insert as needed.

    Insert
  Use this to insert a copy of  the selected element (places right after copied object.) 

To use, select an object and then right mouse click and select “Insert.” It will insert a 
copy of  the selected element.

    Delete
  Use this to delete the selected element. To use select and object and then right mouse 

click and select “Delete.” This will delete the selected object.

    Convert To 
  Click this option to display a list of  different options 

for converting the selected object(s) depending on 
the format it is in. When an object is in stitch format, 
right click options are Complex Fill and Artwork. 
When an object is in Artwork format, right click  
options are Running Stitches and Complex Fill.

    Combine
  Use this to unite multiple paths into a single object. Unlike Group, the combined object 

takes on all of  the properties of  the first object in the sequence. Select twor or more 
objects, right click and select combine from the menu.

    Utility
 Use this for the following options: Echo Quilting, Connect and Simplify. Echo 
 Quilting allows you to choose the specific options for adding Echo features to 
 an object. Connect allows you to connect two or more objects. Simplify reduces the  
 number of  points in an object, creating a smoother final product.

    Align
 Use this to align objects left, horizontal center, right, center, top, vertical center 
 and bottom. To use, select multiple objects and then right mouse click and select 
 “Align”. Next, select the type of  alignment you want to use from the list. 

    Group
 Use this to combine objects into a single object. To use, select the objects and 
 then right mouse click and select Group. 

    Ungroup
 Use this to ungroup objects into a single object. To Ungroup an object, select Ungroup. 

Right Mouse Click Options - Continued
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    Distribute
 Use this to distribute multiple designs 
 horizontally or vertically. 

    Order
 Use this to change the order of  your 
 objects. You can move a design to the 
 back, backward, forward and to the front. 

    Transform
 Use this to open the transform window in the 
 sidebar. Adjust the width, height, position and 
 rotate options are all available in the transform window. 

Right Click Options – No object(s) selected

If  you do not have an object selected, these are the right 
click options available. Some of  these options are only 
available when you right mouse click; others may also 
have a button. Either way is acceptable.  

    Cut
 Option is grayed out. Not available with  no object selected. 

    Delete
 Option is grayed out. Not available with  no object selected. 

    Duplicate
 Option is grayed out. Not available with no object selected. 

    Copy
 Option is grayed out. Not available with no object selected. 

    Group / Ungroup
 Option is grayed out. Not available with no object selected. 

    Paste
  Use this to paste the cut / copied object. Right  mouse click and select “Paste.” 

anywhere on the design page. This will paste a copy of  the cut or copied element 
onto the design page.

    Insert
 Use this to insert a copy of  the selected element (places right after copied object). 
 To use, select an object and then right mouse click and select “Insert.” It will insert 
 a copy of  the selected element.

Right Mouse Click Options - Continued
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    Order
 Option is grayed out. Not availabe with no object selected.

    Transform
 Option is grayed out. Not available with no object selected. 

    View
 Use this tool to change the view on the design page. Lock, Unlock All, Show All, Hide 
 All, Filter and Fade Hidden are options available. 

Right Click Options – Sequence View

The Sequence View is a very powerful panel, which is often overlooked and underutilized. 
This window provides a snapshot of  the entire design. Use the right mouse click inside the
Sequence View for more options. 

    Collapse All
 Use this to collapse all design 
 descriptions into the main description 
 line. 

    Expand All
 Use this to expand the design 
 descriptions from the main description 
 line. 

    View
 Use this tool to change the view on the 
 design page. Lock, Unlock All, Show All, 
 Hide All, Filter and Fade Hidden are
 options available. 

Right Mouse Click Options - Continued
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    Cut
 Use this to cut the selected object. To use, select an object and then right mouse 
 click and select “Cut”. This will remove the selected object from the project, but 
 put it in memory to be pasted somewhere else. 

    Copy
 Use this to copy the selected design element. To use, select an object and then 
 right mouse click and select “Copy”. This will create a copy of  the selected 
 object that can then be pasted into the project. 

    Paste
  Use this to paste the cut / copied object. Right  mouse click and select “Paste.” 

anywhere on the design page. This will paste a copy of  the cut or copied element 
onto the design page

    Duplicate
 Use this to duplicate the selected object. The duplicate will be placed on the 
 clipboard to paste or insert as needed. 

    Insert
 Use this to insert a copy of  the selected element (places right after copied object). 
 To use, select an object and then right mouse click and select “Insert.” It will insert 
 a copy of  the selected element.

    Delete
 Use this to delete the selected element. To use select and object and then right 
 mouse click and select “Delete.” This will delete the selected object. 

    Convert To  
 Click this option to display a list of  
 different options for converting the 
 selected object(s) depending on the 
 format it is in. When an object is in 
 stitches format, right click options are
 Complex Fill and Artwork. When an 
 object is in Artwork format, right click 
 options are Running Stitches and 
 Complex Fill.

Right Mouse Click Options - Continued
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    Utility  
 Use this for the following options: 
 Echo Quilting, Connect and Simplify. 
 Echo Quilting allows you to choose the 
 specific options for adding Echo 
 features to an object. Connect allows 
 you to connect two or more objects. 
 Simplify reduces the number of  points 
 in an object, creating a smoother final
 product.

    Align
 Use this to align objects left, horizontal center, right, center, top, vertical center 
 and bottom. To use, select multiple objects and then right mouse click and 
 select “Align”. Next, select the type of  alignment you want to use from the 
 list.

    Group
 Use this to group selected elements together. To use, select multiple objects and 
 then right mouse click and select “Group.” This will group together all the selected 
 objects. 

    Ungroup
 Use this to ungroup objects into a single 
 object. To ungroup an object, select 
 Ungroup. 

    Distribute  
 Use this to distribute multiple designs 
 horizontally or vertically. 

    Order
 Use this option to move the selected object to the front of  the design where 
 it will be stitched last in the stitching sequence, or to the back of  the design 
 where it will stitch first. To use, select an object and then right mouse click and 
 select “Order” where the available option(s) will be displayed. 

    Transform
 Use this to access the transform tab from the properties box. To use, select 
 an object and then right mouse click and select “Transform.” This will open 
 the Transform box in the properties box where the object may be resized 
 and rotated, among other options.

Right Mouse Click Options - Continued
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Right Click – Design Selected with Shape 

There are many additional options available when you right mouse click on a selected object.  
Only the available options for that object will display. Some of  these options are only available 
with the shape tool when you right mouse click; others may also have a button. Either way is 
acceptable.  

   Update Path 
 Update designt to current path changes

    Edit 
 Use this to edit all, outlines, angle lines 
 or entry/exit points. 

    Add Point
 Use this to add a point to a line. 

    Delete Point
 Use this to delete a point on a line. 

    Split Line
 Use this to split a line. 

    Close Line 
 Use this to close an object. 

    Add Outline
 Use this to add an outline to the selected object. 

Right Mouse Click Options - Continued
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To draw your own designs, use the Draw Tools found on the ribbon 
under the Tools Tab. For all features, right mouse click or press 
Enter on your keyboard to finish. Press the Backspace key to 
delete one point at a time. 

  ICON                SHORTCUT       DEFINITION

To begin drawing with the pencil tool, left mouse click 
anywhere on the design page, and holding down the 
left mouse button, draw. When finished, right mouse 
click or press Enter on your keyboard. 

To begin drawing with the line tool, left mouse click 
anywhere on the design page. Move the mouse and 
click again to create another point. When finished, right 
mouse click or press Enter on your keyboard.

To begin a curved line, left mouse click for the first 
point, then continue to click to place points. Curved 
lines will form between the points.  

Bezier allows you to draw both straight and curved 
lines. For straight lines, use as the line tool. Left mouse 
click to place a point and move the mouse and click 
again to place another point. For curved lines, hold 
the click while moving the mouse. A cusp point will 
appear; manipulate the anchors to achieve the desired 
curve. 

Arcs are parts of  circles. To create a 3 point arc, left 
mouse click for the first point. Click on the design 
space to create two more points, which makes a com-
plete arc. After the first three points, only two points 
are needed to create each arc. 

P

L

C

B

A

To combine all tools while drawing a design, do not right click when finished with a tool.  
Simply select another tool and continue drawing.

Using the Draw Tools 
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Using the Artwork Tools

Since Artwork performs many roles and purposes throughout Pro-Stitcher Designer, it 
is important to understand how to use it. Here are some of  its capabilities:

    Rectangle
 The rectangle creates a four-sided parallelogram or a square. 
  1. Click and hold the left mouse button to create a rectangle. 
  2. Hold down the “Control” key and click the left mouse button to 
      create a perfect square. 

    Ellipse
 The ellipse tool creates circular and oval shapes. It can be an outline or a fill.
  1. Click and hold the left mouse button to create an ellipse. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect circle. 

    Triangle
 The triangle tool creates an isosceles triangle. (For those who are not geometry 
 savvy, that is a triangle with two equal sides and two equal angles.)
  1. Click and hold the left mouse button to create a triangle. 
  2.  Hold down the “Control” key and click the left mouse button to maintain the 

aspect ratio.
    Diamond
 The diamond tool creates a parallelogram on point. It is similar to the rectangle 
 tool, but at a 45º degree angle. 
  1. Click and hold the left mouse button to create a diamond. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect quadrilateral rhombus, or square on point. 

    Star
 The star tool creates 5-point star shapes. 
  1. Click and hold the left mouse button to create a star. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect 5-point star. 

• Artwork may be converted to fill stitches (i.e. standard or motif, shape, echo,  
stippling, wave and grid).

• Artwork may be converted to run stitches.
• Any stitch object may be converted to Artwork.
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    Rounded
 The rounded tool creates a four-sided parallelogram or a square with rounded corners. 
  1. Click and hold the left mouse button to create a round-cornered rectangle           
      or square. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect round-cornered square. 

    Hexagon
 The hexagon tool creates a six-sided rounded polygon shape. 
  1. Click and hold the left mouse button to create a six-sided polygon. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect six-sided rounded polygon. 

    Leaf
 The leaf  tool creates an oval shape. 
  1. Click and hold the left mouse button to create a leaf. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a more rounded leaf. 

    Heart
 The heart tool creates a heart shape. 
  1. Click and hold the left mouse button to create a heart. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect heart. 

    Flower
 The flower tool creates a flower shape. 
  1. Click and hold the left mouse button to create a flower. 
  2. Hold down the “Control” key and click the left mouse button to create 
      a perfect flower. 

Using the Artwork Tools - Continued

QUILTERS NOTE: To modify the shape of  any existing artwork object:

 1. Select the object.
 2. Select the Shape tool.  
 3. Left click on a point to drag it to a new position and release. 
 4. Right click to add an additional point.
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The backdrop may be any raster, or bitmap, image such as .bmp, .png or .jpg; it does not 
have to be a professionally created vector art file. A cleaner and clearer image will produce 
a better result with the Magic Wand tool. It is possible to use image files saved (or exported) 
from a quilt design program, scanned from a pattern sheet or a photograph of  the finished 
product. Be careful to respect any licensing and/or copyright restrictions. 

Select the Backdrop button, then select Load from the drop down menu. A window will open. 
Left mouse click on the desired image, then press open to load the backdrop image to the 
design page. 

    Set the Horizon
 To straighten an image that is crooked, click on the Backdrop button and select Define  
 Horizon from the drop down menu. 

 The cursor will become a + sign. Use any straight line parallel to the top or bottom 
 of  the screen and drag the cursor across while holding down the left mouse key. 
 When the mouse button is released, the image aligns to the new horizon. It is helpful 
 to turn on the grid lines to verify the image is straight. 

    Set the Scale
 If  the image has a border, or the image needs to be resized based on a portion of  
 the image, the transform feature will not be accurate. Transform resizes based on 
 the total image size. Use the Define Scale from the Backdrop drop down menu to 
 determine the size of  the image on a portion of  the image. Click on the slide out 
 menu bar of  the Backdrop button and select Define Scale. Click to set the cursor 
 on the left side of  the portion to measure and drag to the right side. 

 When the mouse button is released, the scale measurement window displays.

 Enter the correct measurement for the 
 portion selected and click OK. The image 
 is resized based on those proportions. 
 The image properties will still reflect the 
 full size of  the image. 

 Both of  these options are repeatable 
 when the Backdrop button is selected.  

Backdrop Features 
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Create Tools: Create Text
    Text in the Text Box
  1. Select the Text tool. 
  2.  Left mouse click on the design page (the word text will appear on the design 

page.) 
  3. In the “Text Box” in the Text View box in the sidebar select the word text in the 
                          text input box. 
  4. Using your keyboard, type the name, message, etc. to add to the design 
                          page. It is also possible to cut and paste from other documents. 
  5. Next, set the text properties such as height, font style, etc. 
  6. Click Apply to display the text on the design page. 

    Text with On-screen Typing
 This option must be checked in the Settings>General Options>View screen. 
  1. Select the Text tool. 
  2. Left mouse click on the design page. A flashing vertical line will appear 
                          inside selection handles. 
  3. Using your keyboard, type the name, message, etc. to add to the design 
                          page. It is also possible to cut and paste from other documents. 
  4. Next, set the text properties such as height, font style, etc. 
  5. Click Apply to display the text property changes on the design page. 

    Circular Text
 Create text using either of  the above methods. 
  1. In Properties – Text, click the arrow to display the Type drop down box. 
  2. Select the “Circle” option. 
  3. Click Apply. 

Tip: For best font selection, position the cursor over the font type box to display all of  the 
character options and size recommendations for that font. 

Create Tools: Editing Text
To select a text with the boxes, diamonds and circles described below, select first 
with the Select Tool and then click on the Text Tool. 

 
 Black Box: moves the text box up or down for given side.
 Black Diamond: allows the text to be moved to any. 
  location.
 Blue Diamond: moves all text to its right along axis.
 Black Diamond – top left: proportionately makes 
  text larger or smaller.
 Black Diamond – bottom right: moves the text inward 
  or outward along axis.
 Green Circle: moves the text outward or inward 
  in envelop manner.
 Purple Circle: rotates the text to left or right.

Creating Designs with Text
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   Black Box: moves the text box up or down for given side. 
 The Black Box, located at each of  the four corners of  the text box, allows the 
 adjustment of  the height of  the text up or down at each given corner. 

   Black Diamond: allows the text to be moved to any location. 
 The Black Diamond, located in the center of  each letter, allows for movement 
 of  the given letter into any location in the work area. 

   
 

   Blue Diamond: moves all text to its right along axis. 
 The Blue Diamond, located between each letter, allows you to shift all letters 
 located to the right of  the blue diamond to the left or right (in the example 
 below, the text was shifted to the right of  the letter “q.”)

To use the Black Box adjustment tool:
• Position the cursor over the black box.
• Left mouse click and hold while dragging          

the cursor up or down. 
• Release the mouse click at the desired                              

position. 

To use the Black Diamond adjustment tool:
• Position the cursor over the Black Diamond          

in the middle of  the letter to move. 
• Left mouse click and hold while dragging            

the cursor to the desired location. 
• Release the mouse click at the desired                

position. 

To use the Blue Diamond adjustment tool:
• Position the cursor over the Blue Diamond 

located to the left of  the letters to shift to                   
the right or left of  their current location. 

• Left mouse click and hold while dragging             
the cursor to the desired location. 

• Release the mouse click at the desired                   
position. 

Creating Designs with Text - Continued
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   Black Diamond – Top Left: proportionately makes text larger or smaller.
 The Black Diamond, located in the upper left-hand corner of  the text box, allows 
 for making the text proportionately larger or smaller (in the example below, the 
 text was made larger.)

   Black Diamond – Bottom Right: moves the text inward or outward along axis. 
 The Black Diamond, located in the lower right-hand corner of  the text box, allows 
 you to move the text inward or outward along the axis (notice in the example below 
 that the text stretches outward but the height of  the text does not change.)

To use the Black Diamond - Top Left 
adjustment tool:
• Position your cursor over the Black Diamond
     located in the upper left-hand corner of  the 
     text box. 
• Left mouse click and hold while moving the 

cursor to the desired location (move up and 
to the right to make the text larger, move down 
and to the right to make the text smaller.)

• Release the mouse click at the                        
desired position. 

To use the Black Diamond - Bottom Right   
adjustment tool:
• Position your cursor over the Black Diamond                       

located in the lower right-hand corner of  the 
text box. 

• Left mouse click and hold while moving the 
cursor either to the left (makes text narrower) 
or to the right (stretches the text wider.)

• Release the mouse click at the desired                  
position. 

Creating Designs with Text - Continued
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   Green Circle: moves the text outward or inward in envelop manner.
 The Green Circle, located in the upper-middle and lower-middle of  the text box, 
 allows you to move the text inward or outward in an envelope manner (notice in 
 the examples below that the text stretches inward, outward or both while the 
 edges stay in the same position.)

   Purple Circle: rotate the text to the left or right. 
 The Purple Circle, located in the upper right-hand corner of  the text box, allows 
 you to rotate the text to the left or right. 

To use the Green Circle adjustment tool:
• Position the cursor over the Green Circle 
     located in the upper-middle or lower-middle of   
     the text box. 
• Left mouse click and hold while dragging the 

cursor either inward or outward. 
• Release the mouse click at the desired posi-

tion.

To use the Purple Circle adjustment tool:
• Position your cursor over the Purple Circle 

located in the upper right-hand corner of                  
the text box. 

• Left mouse click and hold while dragging                  
your cursor either to the left or right. 

• Release the mouse click when you reach            
the desired position.

Creating Designs with Text - Continued
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Auto Digitizing 

The Auto Digitizing option is a great choice for “magically” creating designs. Click on the 
Auto Digitizing button. The following screen will load on your design page. 

     Choose where you want to load your design from 
     (example at right is loading from the computer C:/) 
     and then click Browse. The following screen will load.

     Select the design desired; click on open. The design will 
     populate the path for the image.

     Click on Next. The following screen will load. Select the 
     image size here. Also, transform the image by selecting 
     under Transform: Flip Horizontally, Flip Vertically, Rotate 
     90º CCW (Counter-Clockwise) or Rotate 90º CW 
     (Clockwise). Click Next.
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      In the next screen, you can reduce the number of  colors 
      to simplify the image. There is also the option to edit the 
      image using the program ADWizColorize – Paint. Once 
      the desired changes are made, click finish at the bottom 
      right of  the screen. The auto-digitized design will 
      automatically load to your design page. 

Magic Wand

The Magic Wand Tool is used in conjunction with the draw tools. Load a backdrop image. 
Select a draw tool. Click on the Magic Wand button to activate. Your cursor will now become a 
magic wand.

To digitize a small section of  a backdrop image, left mouse click on any spot within the image. 
The magic wand will trace around the image and create artwork in that shape.

  

Auto Digitizing (continued)
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Pro-Stitcher Designer Keyboard Shortcuts
File Tab
New Design Page   Ctrl + N
Open Design   Ctrl + O
Save    Ctrl + S
Print    Ctrl + P

Edit Tools
Undo     Ctrl + Z
Redo     Ctrl + Y
Cut Selection to Clipboard  Ctrl + X
Copy Selection    Ctrl + C
Paste Selection   Ctrl + V
Duplicate Selection   Ctrl + D
Delete    DEL
Select All   Ctrl + A
Nudge a Selection  Ctrl + Arrow Keys
Insert    Ctrl + I
Connect   Ctrl + T

Arrange
Group Selection   Ctrl + G
Ungroup Selection   Ctrl + U
Move to Front   Ctrl + Shift + ]
Move to Back   Ctrl + Shift +[
Move Back   Ctrl +[
Move Front   Ctrl +]

Tools: While Drawing
Pencil      P
Line     L
Curve      C
Bezier      B
Arc      A
Undo Last Point   Backspace
Snap to Anchor Points  S/

Tools: While Using Shape Tool
Move from one point to 
 the next   Ctrl + Arrow Keys
Delete a Selected Point  DEL
Artwork    0

Selection
Select    Q
Shape      E
Zoom     Z
Pan     M
Ruler     R

View Tools
Zoom in/out on position 
 of  mouse pointer  Alt + Scroll Wheel
Scroll design Page  Arrow Keys
Zoom out     -
Zoom in    +
Zoom to fit    Space Bar
Show/Hide Stitches  Ctrl + Shift+S
Realistic Stitches View  Ctrl + 3
Zoom 1:1   /
Zoom to Selection  .
Show/Hide Backdrop  Ctrl + B
Snap to Grid   Ctrl + 7
Snap to Guideline  Ctrl + 8
Snap to Anchor Points  Ctrl + 9
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